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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Spartan family PLCs are Open Type Controllers. It is required that you install the
Spartan PLC in a housing, cabinet, or electric control room. Entry to the housing,
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cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing Spartan family
PLCs.

e In case of installation or maintenance of the Spartan please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contrdleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de l'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille Spartan sont des contrbleurs de type ouvert. Il est
nécessaire d'installer I'automate Spartan dans un boitier, une armoire ou une salle de
contrble électrique. L'accés au boitier, a l'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille Spartan.

e En cas d'installation ou de maintenance du Spartan, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: - Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’'S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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ETL Listing Mark-Direct Imprint information

RECOGNIZED
COMPONENT
o™ Conforms to UL Std. 61010-1
Conforms to UL Std. 61010-2-201
C us Certified to CSA Std. C22.2 No. 61010-1
LiSTED Certified to CSA Std. C22.2 No. 61010-2-201
Intertek
5016476
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INDUSTRIAL SHIELDS

1 General Description SPARTAN 21 I/0s product

1.1  Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and B the shield from above. It has 2 zones (A, B):

e The inputs in the zone B are hamed 10.X, being X any number suitable in the
Shield. Outputs are named as QO0.X.
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1.2 Zone Distribution

The distribution of the different features that provide the Spartan 21 I/Os is the

following one:

Communication

Y

Analog

Y

Digital

Shield B Zone
12 Inputs
(12 Digital inputs, 6 of which can work as Analog Input)
Analog Shield

8 Outputs
(8 Digital Outputs, 3 of which can work as Analog

Output)

1.3 A Zone Features

Shield

A Zone

Communication
Shield

(1x) Ethernet

(1x) USB

(3x) TTL

(1x) RS-232

(1x) HALF Duplex RS-485

Rev. 1: 09-04-2021
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1.4  Mechanical dimension
A T
1.5 General Features
CONECTABLE PLC ARDUINO 24Vcc SPARTAN
MODEL TYPE Spartan Arduino PLC 21 IOs
Fuse protection (2.5A)
Input Voltage 12_"372:“/‘“ Polarity protection
Input rated voltage 2_4?\@0
Rated Power 30w
| max. 1.5A
Size 101x70.1x119.5
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

Ethernet Port — USB — RS485 — RS232 — (2x) Rx, Tx
(Arduino pins)

Max232-Max485-W5500

USB consideration!

Only meant for uploading or debugging, not
always connected as a serial in a project!

Cannot be working in afinal
application

An/Dig Input 10bit
(0-10Vcce)

0to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

Digital Isolated Input
(24vcce)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

14
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* Interrupt isolated
Input HS (24vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Analog Output 8bit
(0-10Vce)

0 to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated
Output (24vcce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Digital Isolated
Output Relay

220V Vdc
I max: 5A
Galvanic Isolation
Diode protected for Relay

PWM Isolated Output
8bit (24vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Expandability

Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

15
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2 Technical Specifications:

2.1  General Specifications:

Item

Spartan PLC Arduino Ethernet 21 I/Os Analog/Digital PLUS

Power supply

voltage DC power supply

12 to 24Vvdc _—=

Operating

voltage range DC power supply

11.4t025.4Vdc ===

Power
consumption DC power supply 30W max.
Power supply 2avde ===
External voltage
power supply Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 378g max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutoria/HomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz

16
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2.3

Symbology

Rev. 1: 09-04-2021

Table that includes all the symbology that is used in the serigraph of the Spartan Arduino PLC

21 1/0s Analog/Digital:

Symbol Standard No. / Standard Symbol Meaning
Standard Title Reference No. /
Symbol Title
IEC 60417 / 5031 / Direct Indicates that the equipment is
] Graphical symbols Current suitable for direct current only;
HE BN =Em for use on to identify relevant terminals
equipment
IEC 60417/ 5032 / Alternating | Indicates that the equipment is
Graphical symbols Current suitable for alternating current
for use on only; to identify relevant
N equipment terminals
IEC 60417/ 5130/ Pulse To identify the control by
Graphical symbols General which a pulse is started.
for use on
equipment
IEC 60417 / 5017 / Earth, To identify an earth (ground)
Graphical symbols Ground terminal in cases where
for use on neither the symbol 5018 nor
p— equipment 5019 is explicily required.
IEC 60417/ 5115/ Slgnal lamp To identify the switch by
Graphical symbols means of which the signal
for use on lamp(s) is (are) switched on or
equipment off.

Medical Devices CE Marking CE marking indicates that a
Directive product complies with
93/42/EEC applicable European Union
regulations
ISO 7000/ 0434B / Indicates a potentially
Graphical symbols | Warning symbol hazardous situation which, if
for use on not avoided, could result in
equipment death or serious injury
ISO 7000/ 5036 / Dangerous To indicate hazards arising
Graphical symbols Voltage from dangerous voltages
for use on
equipment

17




Ref. 017001000200 Rev. 1: 09-04-2021

3 Precautions

Read this manual before attempting to use the Spartan Arduino PLC 21 I/Os Analog/Digital and
follow its descriptions for reference during operation.

3.1 Arduino Board

The Spartan 21 1/0s PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Spartan according to the performance specifications described in this
manual.

Before using Spartan under different conditions from what has been specified in this manual
or integrating Spartan to nuclear control systems, railroad systems, aviation systems, vehicles,
combustion systems, medical equipment, amusement machines, safety equipment and other
systems, machines, and equipment that may have a serious influence on lives and property if
used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and
performance characteristics of Spartan are sufficient for the systems, machines, and
equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operating the Spartan.

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

18
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Steps:
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1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences

Settings | Network:
Sketchbook: location
C:\Users\Albert\Documents!Arduino
Editor language: English (English)

Editor font size: 15

Interface scale: Auﬂmﬂat\c 100 % %%

Show verbose output during: ompilation upload

Compiler warnings: None v
[Jpisplay line numbers

[Jenable code Folding

[] verify code after upload

[ use external editor

Check for updates on startup

Save when verifying or uploading

Update sketch files to new extension on save (pde - .ino)

Browse

~| (requires restart of Arduino)

(requires restart of Arduina)

Additional Boards Manager URLs: | http://apps. industr ialshields.com/main/arduino/boards/package_industrialshields_inde: [

an be edite ectly in the file

More prefer
C:\Users\Albert\appDataiLocal\Arduino 15\preferences, tet

oK Cancel

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

© skewch_mar16a | Arduing 180

File Ecit Sketch Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Senal Plotter

WFi101 Finmware Updater
Board: "M-Duino family”
Inchusirial Shielcls: "M-Duino 58+
Port

Get Board Info

Programmer: “Ardhino as ISP’
Burn Bootioader

- _
M

Boards Manager...
uino AVR Boards
Arduine Yiin
Ascluino/Genwino Una
Arduino Duemilanove or Diecimila
Arduine Hano
Asduino/ Genano Mega of Mega 2560
Arduing Mega ADK
Arduino Leonardo
Arduino Leonardo ETH
Arduino/Genwino Micro
Ascluino Esplora
Arduino Min
Arduino Ethernet
Ardhino Fio
Arcuino BT
LilyPad Arduno US8
LilyPad Archino
Archuing Pro of Pro Mim
Aschuine WG or older
Arduin Robot Control
Arduino Robot Motor
Arduino Gemma
Adalruit Circuit Payground
Arduino Yun Mini
Arduine Incustrial 101
Linino One
Arduing Uno Wit
Indusinal Shiekds boards
Ardbox family
# M-Duino family

19
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5. Search for “industrialshields” on the browser.

€ Boards Manager X
Type All ~ | lindustrialshields
industrialshields ~

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

~ | Install

v
Close
6. Click install (selecting the latest version).
Following these steps, you will be able to see now the Industrial Shields Boards:
© sketch_dec09% Arduino 1813 - 8 x
Archivo Editar Programa Herramientas Ayuda
Sy g
pi] emacael e 7
// put yor SeralPloter CrisMayissl nc

WiFi101 / WIFININA Firmware Updater

} Placa: “Spartan family" 3 Gestor de tarjetas
Model: *Spartan 19R" ==
Puerto ESP32 Arduino

P () | Obuninformacion dela placa Industrial Shields boards

Industrial Shields ESP32 modulg

Ardbox family
Ardbox DALI family
Ardbox GRS family
Ardbox WiFi/BT family

Programador
Quemar Bootloader

} Ardbox LoRa family
M-Duina family
M-Duino DALI family
M-Duino GPRS family
M-Duino LoRa family
M-Duino WiFi/BT family
| Spartan tamily
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Once it is selected Spartan family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

@ sketch_dec09a Arduino 1.8.13

Archivo Editar Programa  Hemamientas Ayuda

WIFi101 / WIFININA Firmware Updater

} Placa: “Spartan family

| Sparan 16DA
4 Spartan 16RDA
de la placa Spartan 19R

i ® Sparan 21

Also, there are some examples of programming in File -> Examples -> Spartan family.

Furthermore, there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Spartan 21 1/Os uses USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> Spartan family
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- Select the correct Spartan Board (Spartan 21).

@ sketch_dec09a Arduino 1.8.13 - [=] ®
Archivo Editar Programa Heramientas Ayuda

PEEERE] oo T
Archivo de programa
Reparar codificacion & Recargar.

Administrar Bibliotecas. CtleMayds+! S
t Monitor Serle - Mayis =M
// put Serial Plotter [ —

WIFi101 / WIFININA Firmware Updater

} Placa: “Spartan family >
Madel “Spartan 21" | Sparan 16DA
Puerto 2 1= RDA

pQ Obtén informacién de la placa

// put you Programader

Quemar Bootloader

Spartan 19R
Spartan 21

- Select correct port.

@ sketch_dec09a Arduino 1.8.13
Archivo Editar Programa Herramientas Ayuda

Administrar Bibliotecas. CirleMayiis+]

PEEERE] oo Cini+T
Archivo de programa
de Reparar codificacion & Recargar.

Manitor Serie Ciri+Mayis +M
Serial Plotter CrrisMayis+L

WiFi101 / WIFININA Firmware Updater

} Placa: “Spartan family >
Model: *Spartan 21 >
Puerto: “COM3 (Arduino Mega or Mega 2560)" ]
p ) Obtén informacién de la placa ¥ COM3 (Arduino Mega or Mega 25601
7/ PUE YOU  programaor Jjedly:

Quemar Bootloader
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6 How to connect PLC to power supply
- Spartan 21 1/0s PLC is 12-24Vdc supplied. IMPORTANT: The polarity IS NOT REVERSAL!
- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[——
u GHND I

rpa |

| I ——

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail: QZ‘ (I
-12vdc / 24Vdc o

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,

EBE |

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7 Spartan 211/0s Pinout

7.1 A Zone connection

Base

Rev. 1: 09-04-2021

Arduino direct pins

Communication Pins

Power supply connectors

(common unit)
L] ]
A Zone
zs & L ]
58 | @ 15 .
X c = =] APef
< c 3 e SOW
o o e = Ref
n O < L 33vdc
E»./.'L
AREF AREF Arduino PIN
SQW SQW Arduino PIN
IOREF IOREF Arduino PIN
3.3Vvdc 3.3Vdc Arduino PIN IRXT
5Vvdc 5Vvdc Arduino PIN T
GND GND GND F“ [
NC - Not Connected INC
NC - Not Connected NC
RXO0 1 RX0 i
TX0 0 TX0 A &
RX1 19 RX1 N
X1 18 T>1 o
X 16 RS232 NC
RX 17 RS232 !“H
NC - Not Connected Faty
NC - Not Connected GNI
B- - RS485 e
A+ - RS485 %3 _
NC - Not Connected Vo & (24vdc - GND)
NC - Not Connected ——‘
NC - Not Connected
NC - Not Connected E&
NC - Not Connected
V5 5Vvdc 5V
PIN2 2 Arduino Pin
GND GND
GND - GND
24Vdc - Power Supply
é 8
1 RS
¥ 3§ "B @ = o i
z ZEm 2o g
E 33 CE 8
§ < & 3
E5 'RTC Batiery (CB#20) 45D Socket[] l\
Ethernet Arduino / Power
Connector Reset button

USB programmer
connector

Autoreset

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield)
N D
B Zone
5 £
85 Dc; c 0 to 10vee
8 o £ 2 Dgrtal_
o c =} 15} 3 to c4Voc
n Q ° 5
o < L Digite
S to 24Vdc
10.12 59 Analog/ Digital In ,
10.11 58 Analog/ Digital In *
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55! Analog/ Digital In
10.7 54 Analog/ Digital In
(-)10.6/INT1 - GND 10.6 g
10.6/INT12 3 Interrupt 1 In 106/INT1 e
NC - Not Connected NC Interrapton Pe
NC - Not Connected NC
(-)10.4 - GND 10.4 e B
10.4 26 Digital Input 104 g
()10.3 - GND 10.3 ) 103 s
10.3 25 Digital Input 03 - 3
()10.2 5 GND 10.2 s £
10.2 24 Digital Input ) 101
(-)10.1 - GND 10.1 10
10.1 23 Digital Input ) 10
()10.0 - GND 10.0 ]
10.0 22 Digital Input
Top Zone
=== 2F==°° ¥t b
1 NC NC
Led indicator I/Os state o R
40.5 00.5
L2 ™
B Zone
1) Anolag
+ 0 to 10V
S B c g to
g © [ s "}?m‘
© O o =1 ORIy
(% g c 8 . -[l“'“ ol /PWM:
o =1 =1 AVoc
o = w
<
GND GND GND
A0.7* 6 Analog Out
A0.6! 5 Analog Out 8
A0.5! 4 Analog Out 8
Q/Vdc - External Isolated Out Vdc H
COM() - External Isolated Out GND < 2)
Q0.71 6 Digital/PWM Out 3
QO0.61 5 Digital/PWM Out 3
Q0.5 4 Digital/PWM Out g
Q0.4 40 Digital Out b
Q0.3 39 Digital Out P
Q0.2 38 Digital Out | 2°
Q0.1 37 Digital Out "
Q0.0 36 Digital Out

Rev. 1: 09-04-2021

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

1 See section 8 to select suitable switch configuration for enable these connections.
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8 Switch Configuration

SWITCH OFF | ON
NC/NC - -
A0.7/Q0.7 | A0.7 | Q0.7
A0.6/Q0.6 | A0.6 | Q0.6
A0.5/Q0.5 | A0.5 | Q0.5

OFF ON

NC NC
A0.7 QO.7
A0.6 QO0.6
A0.5 Q0.5

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF,
it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with Q0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with A0.X, being X any number of the tables above.
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9 SPARTAN Arduino I/0s 5V pins

The SPARTAN ARDUINO PLC 19R I/Os Analog / Digital has some of the Mega board pins
available. These pins can be programmed according to Arduino features such as 1/Os
operating at 5V or any additional features present in the pins. As these pins are directly
connected to the Arduino Mega board, they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some
of these pins the configuration switch must be set to OFF position (see section 8) and some
extra considerations must be taken in consideration when using these pins.

SPARTAN terminal Arduino pin Enable Arduino pin
RX0 0
TXO0 1
RX1 19 Communication switch OFF
TX1 18 Communication switch OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

Apart from the switch configuration, there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.

9.2  Serial 1 - RX1/TX1

These pins are only referred to the inputs 11.5/11.6. The RX1/TX1 pins will only be available
if the switch configuration is in OFF position. If not using the Serial 1 interface these pins
can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.
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93 Pin2

This pin is referred to the input 10.1. This pin is not established with a pull-up or a pull-down
configuration by default. The Arduino board allows the pin to be set in a pull-up configuration.
Otherwise, an external pull-up or pull-down circuit could be set.

10 A Zone Features: Communications & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the SPARTAN is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there is not any switch that affects it. So, it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields there is a library that simplifies the RS-232
implementation.

10.2 RS-485
For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 TTL

SPARTAN has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins
0 and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

10.4 Ethernet

SPARTAN Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the SPARTAN. In the SPARTAN, W5500 IC communicates to the Mega board via SPI bus
(SS Arduino Mega pin 10).
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11 Instructions for interconnection between Industrial Shields

controllers

11.1 RS-232 Communication:

~ M-Duino 19R
" I/I0s PLUS

- ~—
{

KRFC-6 Ferrite (4 Loops)

T f A

SHIELDED CABLE

S Another Industrial

Shields PLC

R8-232

Ferrite KITA Ferrite KITA
GND L GND
12124V W 12024V
11.2 RS-485 Communication:
M-Duino 19R ' *. Another Industrial
1/0s PLUS | Shields PLC
KRFG-6 Ferrite {4 Loops)
LA 1A
SHIELDED CABLE
Ferrite KITA Ferrite KITA
GND , L GND
12/24V @OC}O( 12724V
11.3 Ethernet
KRFC-8 Ferrite  SHIELDED CAELE
U —J‘*—- — Ethernet — *%‘*l —
M-Duino 19R ' ~ Another Industrial
I/0s PLUS Shields PLC
Ferrite KIT) Ferite KITA
GND i GND
12/24V mc}@ 12/24V
- N s B

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.
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12 1/0 technical details:
Digital Output Waveform:

[N o e——
v

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CH1= S.@ay| kRS S.0084) M 1.88ms| | CHI T 268m.)

30



Ref. 017001000200 Rev. 1: 09-04-2021

Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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13 Typical Connections

Rev. 1: 09-04-2021

(,,Wu ISOLATED INPUT \

&
&

GND
Sharzev

‘] (100

o/,c;jﬁ.ﬁ

SHIELDED CABLE

Ferrite KITA

@l

i

SHIELDED CABLE

/ Dowrdoad e MDUND LAYOUT:
From®

< e N

S T

Ferrite KITA

o

0 POWER

B oomaw

SHIELDED CABLE .|| Duumlon s MOURO LAVOUT:
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SHIELDED CABLE
2124V o 0.7
GND

Ferrite KITA
0

Lo g ) o

SHIELDED CABLE ~ /  From wemiierssvohoon \
< ey U

010V

— T2, L

Ferrite KITA

GND

L) POWER
2224V B oemauasaocew

SHIELDED CABLE L:":‘:"W \
no—
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SHIELDED CABLE

0-10v

@ 51224V
GND
Ferrite KITA
GND A
12024V

Ferrite KITA

0.7

Rev. 1: 09-04-2021

SHIELDED CABLE Downioed e MOUINO LAYOUT!
i From: www.industrisishisids. com \

SR

B owemuour

Qo0 <)

SHIELDED CABLE

£\

L

SM2r24v
oA

VOUT = @/ Vde

SHIELDED CABLEf Pty drussentt felipocd \_

ALWAYS
CONNECTED
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SHIELDED CABLE

Ferrite KIT/

GNI}_'G

2124V

Rev. 1: 09-04-2021

VOUT = O/ Ve

SHIELDED CABLE

DIGITAL / PWM |SOLATED
OUTPUT

Ferrite KIT,

A

" \
E
v [

DIGITALFWAS OUT

SHIELDED CAEL? st vy ol k

* Sow the swilch
configutarion (ON)
f 51224V
{ oo A
J ALWAYS
JU1 CONNECTED
® SHIELDED CABLE
VOUT = Q/ Vide
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* Soo the switch
configutarion (ON)
Q/Vde
COM (=) gﬁw
Jn CONNECTED
Ferrite KITA 05 @
B Mﬁ] VOUT = Q/ Vide
224V DAGETALPWA OUT
SHIELDED ASL;/—ELT%
\J y
SHIELDED CABLE
—
(/_:uuoeou-rpur )
\I * Analog Outs no led r’f
indlicator
S B * See the switch
1[0 g Olos configutarion (OFF)
M.ii[{;u GND =
@3/0 g O| 02 AO5 E‘—” “'W)
g
ME SHIELDED CABLE
NCiOD O WI!/
Ferrite KITA —ia o
GND
= 9) |} power
20N | 8 ANALOG OUT
SHIELDED CABLE Dowibad o MOMOLAOUT: |
/ e
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502 from
Phoenix contact. MC0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension Spartan 21 I/Os:

0
-
8=
<t
- DIN Rail mounting
Profilato o cappello TH 35-7,5 Prafilato o cappello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
155,
RO8
RO
]
=
+ L_
SRS 1=004
Sezione A/ Section A .
o~ 2,2 min. finoa / To 2,5 max
= -
7l
B Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PU/ABS METHOD PUABS
Mecconiche  Reigoreo o tuzioneolo srenomente  ASTM D638 MPo 68 Mechanical fest Resiionce o tesile stess f yield ASTMDS38 MRy 68
Redisoreo o tuzionea nttw ISTIDB3E  MPo 48 Tonglostength ASTMD638 MR %
Allngomento o totin K088 9 i o ASTMD638 % 9
Mool in fesione STADIN _ MPo 2894 Pleing modules ASTADTS0 MR 7894
Pova Iz0d con intoglio 150180/14 X/ 55 rod test noiched 1018014 X' 55
Termiche Temp di nmmolinento Viat, medoB AT DIS2S  °C 114 Thermal fest Vit sodtening tomperctuee method B ASTMDIS2S 114
Tomperoun Ricto 1 81 My K068 °C 91 Rebeting temperatue 1,81 WPg ASTMD848  °C 9
Fisiche Peso gadfin K092 géamd n Physical test  Spaciic gy ASTHDT®? _ géand 12
Riti nello stompo STADSS % 0408 Mould hiinkage ASTMDSS % 0408
Mol Flow Index 260°C - 98N KSTNDIZE  o/10° 111 Melt Flow Ines 260°C - 98N ASTMDIZ38 10’ 11
Comportamento Avbesinguerza (i di pesoe) [I2) - V-0(08) Flome fest Self atinguishr (thidness in mm) L4 - V0(08)
allo fiomma _Fib Incadescen 37 mm 69521 °C 960 Inndestents thiepd 32 mm IEC89521 960
Italtronic si riserva il diritto di modificare il moteriole con cui realizzo i propri prodotti Italtronic con operate ony change of the materials without being obliged to forewam.
senzo obbligo di preawviso.

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the Spartan 21 1/Os from heat, high voltaje and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
Spartan 21 1/Os. When configuring the layout of the Spartan 21 I/Os inside your panel,
consider the heat-generating devices and locate the electronic-type devices in the cooler
areas of your cabinet. Reducing the exposure to a high-temperature environment will
extend the operating life of any electronic device. Consider also the routing of the wiring
for the devices in the electric cabinet. Avoid placing low-voltage signal wires and
communications cables in the same tray with AC power wiring and highenergy, rapidly-
switched DC wiring.

Provide adequate clearance for cooling and wiring Spartan 21 1/Os. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
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above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25c¢cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires

40



Ref. 017001000200 Rev. 1: 09-04-2021

and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Rev. 1: 09-04-2021

Revision Number Date Changes
0 03/12/2020 First implementation
1 09/04/2021 Minor changes
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev. 1: 09-04-2021
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